
 
 
 
 
 
 
 
 

Drupal State Agency Websites 

Documentation 
  



Drupal Documentation 

 

rev. 7/2018 2 

Index 
 
REQUEST A NEW USER ACCOUNT ........................................................................................................................ 3 

RESET PASSWORD ......................................................................................................................................................... 3 
LOG-IN ................................................................................................................................................................. 3 
ADMIN OVERVIEW .............................................................................................................................................. 3 

CONTENT SECTION ........................................................................................................................................................ 4 
STRUCTURE SECTION ...................................................................................................................................................... 4 

CREATE A NEW PAGE ........................................................................................................................................... 5 
CREATE THE URL PATH .................................................................................................................................................. 5 

EDIT A PAGE ........................................................................................................................................................ 6 
REVISIONS ........................................................................................................................................................... 7 
UN-PUBLISH A PAGE ............................................................................................................................................ 7 
SCHEDULED PUBLISHING/UN-PUBLISHING .......................................................................................................... 8 
DELETE A PAGE .................................................................................................................................................... 8 
EDIT FOOTER ....................................................................................................................................................... 8 
MENUS ................................................................................................................................................................ 9 

ADD PAGE TO MENU ...................................................................................................................................................... 9 
REMOVE PAGE FROM MENU .......................................................................................................................................... 10 
LINK POSITION IN MENU ............................................................................................................................................... 10 
DISPLAY MENU IN CERTAIN SECTION ............................................................................................................................... 11 

TIPS .................................................................................................................................................................... 12 
HOW TO UPLOAD AND LINK TO A DOCUMENT (PDF, WORD, ETC.) ........................................................................................ 12 
LIST OF ALL UPLOADED FILES/DOCUMENTS ........................................................................................................................ 12 
HOW TO GET THE URL OF AN UPLOADED FILE ................................................................................................................... 12 
CLEAR TEXT FORMAT .................................................................................................................................................... 12 

  



Drupal Documentation 

 

rev. 7/2018 3 

Request a new User Account 
 
The web coordinator (or person in charge of the website) has to send an email to InforME 
(creative@informe.org) with the website URL, full name and email address of the person that 
needs a new user account, and the user role this person should get. 
 

Reset Password 
 
Please use the "Forgot Password" link that will show after you entered the password wrong. 
(While your website is still in development, email creative@informe.org for a password reset)  

Log-in 
 
To log in to your website admin, go to the homepage of your website and add /user/login at 
the end of the URL. This will bring you to your log-in screen. 
 
Example: https://www.maine.gov/corrections/user/login 
 

 
 
 

Admin Overview 
 
Once you are logged into your admin, you will see your admin bar at the top of the browser 
window.  
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Note:  
 

• Depending on your user role and permissions, you might see more/less options in the 
admin bar.  

• Only users that are logged into the admin see this bar. It is not visible to website visitors. 
 
Depending on your tasks and user role, you will only need the "Content" and "Structure" 
sections of the admin to maintain your website. 
 

Content Section  
 
Go to "Content" for all content related changes/updates of your website. 
 
Here you will find a list of all pages, images and files/documents of your website. 
 
To find specific content, you can use the filter option at the top of the page: 
 

 
 
 

Structure Section 
 
In this section you create/update the 
menus of your website. Depending on 
your user role, you might not have 
access to this section. 
 
The most relevant part in this section is 
the "Menus" section. 
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Create a new Page 
 
To create a new page 
 

1. go to the "Content" tab in your admin bar and then 
2. click the blue "+ Add Content" button at the top:  

 
On the next screen you can choose which page template you want to use. (Unless your website 
had some special templates created by InforME, you will most likely only see "Home Page" and 
"Basic Page Template") 
 

3. Select "Basic Page Template" (® used for all pages of your website, except the 
homepage) 

 

 
 
On the next screen: 
 

4. Enter the page title 
5. Enter the page content in the "Body" field 
6. If your page has a right sidebar, enter that content into the "Right Sidebar Content" field 
7. You can preview the page by clicking "Preview".  
8. Before you save/publish your page you need to create an URL path for the page (see 

next section in this documentation) 
9. To publish the page, select "Published" and click "Save". 
10. To save the page without immediately publishing it, uncheck "Published" before saving. 
 
 

Create the URL Path  
 
Important: You have to create a URL for every page you create, or else Drupal generates a 
generic URL like https://www.maine.gov/corrections/node/32/ which is not ideal. 
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After entering your page's content, find the "URL Path Settings" section in the right column: 
 

 
 
If you want your About page to live at https://www.maine.gov/corrections/about you have to 
enter /about (or whatever the name of your page is) 
 
If you have a contact page that should live in the About section of your website, you'd enter 
/about/contact so the URL of the page would be 
https://www.maine.gov/corrections/about/contact  
 
 

Edit a Page 
 
There are two ways to edit a page: 
 

1. Go to the "Content" tab in your admin bar and find the page you want to edit and click 
the "Edit" button on the far right. 

 
 or 
 

2. Navigate to the page on your website, hover over the main content with your mouse 
and click the little pencil icon that appears at the top right of the content. Click "Edit". 
Note: The pencil icon will only appear when you are logged into your admin. 

 

 
 
On the edit screen, make your content changes and click "Save". The changes will now show up 
on your website.  



Drupal Documentation 

 

rev. 7/2018 7 

Revisions 
 
In case you need to undo changes, you have made to a page, you can revert back to an older 
version of the page. To do this 
 

1. Go to the "Content" tab in your admin bar and find the page you want to edit and click 
the "Edit" button on the far right. 

 
 or 
 

2. Navigate to the page on your website, hover over the main content with your mouse 
and click the little pencil icon that appears at the top right of the content. Click "Edit". 
Note: The pencil icon will only appear when you are logged into your admin. 

 
At the top, click on the "Revisions" tab and then select the version you want to revert back to. 
You can preview the revision by clicking on its date. 
 

Un-publish a Page 
 
Drupal gives you the option to un-publish a page. Reasons for this might be: 
 

• you haven't completed the page yet and want to finish it at a later time 
• the page shouldn't be public at the moment but should be made public again in the 

future 
 
 
 There are two ways to un-publish a page: 
 

1. Go to the "Content" tab in your admin bar and find the page you want to un-publish and 
click the "Edit" button on the far right. 

 
 or 
 

2. Navigate to the page on your website, hover over the main content with your mouse 
and click the little pencil icon that appears at the top right of the content. Click "Edit". 
Note: The pencil icon will only appear when you are logged into your admin. 

 
On the next screen, scroll all the way down and uncheck "Published" and save the page. The 
page won't be visible on your website anymore and you have to navigate to it in the "Content" 
section in your admin if you want to work on it or publish it again. 
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Scheduled Publishing/Un-Publishing 
 
If you wish to schedule the publishing or un-
publishing of a specific page, you can do so by 
entering the date and time of when you want to 
publish or un-publish the page in the right sidebar 
under "Scheduling Options". 
 
 
 
 
 
 

 

Delete a Page 
 
Depending on your user role, you may or may not be able to delete content from the website. If 
you have permissions to delete a page, there are two ways to delete a page: 
 

1. Go to the "Content" tab in your admin bar and find the page you want to delete and 
select "Delete" from the dropdown button on the far right (by default it says Edit) 

 
 or 
 

2. Navigate to the page on your website, hover over the main content with your mouse 
and click the little pencil icon that appears at the top right of the content. Click "Delete". 
Note: The pencil icon will only appear when you are logged into your admin. 

 
You will be asked to confirm that you want to delete the page.  
 
Important: Once you delete a page, it cannot be recovered!  
 

Edit Footer 
 

To edit any of the footer content, hover over the footer column you'd like 
to edit and click on the little pencil icon that appears. Note: The pencil 
icon will only appear when you are logged into your admin. 
 
Click either "Quick Edit" to edit the content on the page  

or "Edit" to edit the content in the backend/admin.  Make sure to save your changes. 
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Menus 
 
Depending on your user role, you might not have permissions to edit your website's menus. 

 
Add page to Menu 
 
There are two ways to add a page to a menu: 
 

1. When you create a page, you can add the page to a menu by checking "Provide a Menu 
Link" in the right sidebar under the Menu Settings: 

 
Menu link title: Title that will show up in the 
menu 
 
Description: Leave blank 
 
Parent item: Menu you want to add the page to 
 
Weight: Determines the position of the link in 
the menu. Lower weight means the link will 
show up further down. 
 

 
2. Go to "Structure" ® "Menus" and click on the "Edit Menu" button of the menu you 

want to update. 
 
On the next screen click the blue "Add link" button. Enter the Menu link title. In the Link 
field, start typing the title of the page you are trying to add, and Drupal should 
automatically find it for you.  
 

 
 
You don't have to enter the weight because once you added the link to the menu you 
can drag and drop the link to the position in the menu you want it to have.  
 
Save the menu! 
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Remove page from Menu 
 
To remove a page link from a menu, go to "Structure" ® "Menus" and click on the "Edit Menu" 
button of the menu you want to update. 
 
On the next screen, find the page link you want to remove and select "Delete" from the "Edit" 
drop down button. 

 
 
 

Link Position in Menu 
 
You can position a link in a menu by dragging and dropping it in the Menu admin.  
 
Go to "Structure" ® "Menus" and click on the "Edit Menu" button of the menu you want to 
update.  
 
On the next screen, drag the link by the cross arrow and drop it where you want it to appear in 
the menu. Make sure to save the menu afterwards or else your changes won't show up on the 
website. 
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Display Menu in certain section 
 
You can tell Drupal to display a menu on certain pages or in a certain section of your website.  
 
For example, the left menu with the sub-pages of your About section should only show up in 
the About section of your website.  
 
To do this, go to "Structure" ® "Block Layout" and find your menu under "Left Navigation" 
headline. Then click "Configure": 
 

 
 
On the next screen, go to "Pages" under "Visibility". Here you have to tell Drupal on what pages 
to display your menu. In the example below, we tell Drupal to display the menu on the about 
page (/about) and on all pages that live under about (/about/*).  
 

 
 
Click "Save Block" when you are done.  
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Tips 
 

How to upload and link to a document (PDF, Word, etc.) 
 
To add a document to your content, highlight the text you want to be the link and then click the 
upright paperclip:  
 
If you like to link to a document that you have previously uploaded, highlight the text you want 
to be the link and then click the link symbol with the little plus:  
In the pop-up window, start typing the name of the document 
and select the correct file from the list that drops down, then click save.  
 
 

List of all uploaded files/documents 
 
You can view a list of all of your uploaded files under the File tab in the Content section of your 
admin. To view a file, just click on the name of the file. 
 
 

How to get the URL of an uploaded file 
 
Go to the "Files" tab in the content section of your admin and right click on the file name link, 
then click "Copy link location".  
 

Clear text format 
 
If the page content you copied and pasted from Word looks different (font, size, color, etc.), 
highlight the text and click the little Tx button to remove all formatting. Copying text from Word 
sometimes brings over also Word's formatting which can mess up your content's styling. 
 

 
 


